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Accessing TIBCO Business Studio Help

You can access TIBCO Business Studio Help either online when using TIBCO Business Studio or by
downloading it for use at any time.

TIBCO provide Out-Of-Cycle updates of product documentation. If you have downloaded the help already,
and want to be notified of these updates for TIBCO Business Studio, navigate to the current version of
TIBCO Business Studio documentation on the TIBCO Product Documentation page, and click Subscribe to
subscribe to the RSS feed. When notified of an update you can re-download the html from the Product
Documentation site to use the latest version. Copy it to the location of the existing help and access it from
TIBCO Business Studio, or download it as described below to replace previously downloaded help.
Alternatively you can go back to Preferences and re-download the help from there.

If your environment requires accessing of the internet via a proxy then go to Window > Preferences >
General > Network Connections and configure the proxy settings.

Procedure

1. Go to the Help menu.

2. Select Download Offline TIBCO Help.... This guides the user to the appropriate Preferences page
(Preferences > TIBCO Help > Content).

● Content access strategy: Prefer offline help (if available). (default) is already selected, but online
help will be used until help is downloaded. The alternative selection is Always use online help.

● To define where you want the offline help to be located, Browse to the location in which you want
to save the Base offline documentation folder and click Apply. You can click Location to go to the
location that is defined.

● Select the help you want to download and click Download and OK.

● The help is downloaded to the location specified in the Base offline documentation field. If the
Prefer offline Help (if available). content access strategy is selected then then the downloaded help
content will be used. Once the help is downloaded then the Help > Menu items will open the
downloaded offline help.
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Installing TIBCO Business Studio - Analyst Edition

TIBCO Business Studio - Analyst Edition and Community Edition can be installed in GUI mode or silent
mode. This guide refers to the Analyst Edition but it can also be used to install the Community Edition.

Before installing TIBCO Business Studio - Analyst Edition you need to ensure that you have the correct
system requirements. See System Requirements.

After installation, there are post installation tasks you may need to perform. See Perform Post Installation
Upgrade Tasks.

System Requirements
Make sure that your target computer meets the necessary system requirements to install TIBCO Business
Studio - Analyst Edition.

The system requirements are also listed in the readme file, which is available in the installation set in the
\docs folder or from the TIBCO download site.

Supported Platforms
TIBCO Business Studio - Analyst Edition is supported on various platforms.

Note that:

● The Supported Versions specified are the minimum versions of each operating system that are
supported by TIBCO Business Studio. Any subsequent services packs, updates, patches or fix packs (as
appropriate) for the specified versions are also supported.

● Other (64-bit) Linux implementations detailed in the following link have not been formally validated,
but have no known incompatibilities with this version of TIBCO Business Studio.

http://www.eclipse.org/eclipse/development/plans/eclipse_project_plan_4_7.xml#target_environments

● On Linux platforms, the threshold value for the maximum number of open files/file descriptors that a
user can open is typically too low for use with TIBCO Business Studio. You should increaase this value
to at least 10000. (You may need to increase it further depending on the features selected during
installation and the size of the workspace, but this value is typically sufficient.) You can use the ulimit
-n command to display the current value on your system.

TIBCO Business Studio - Analyst Edition (64-bit)

Operating
System (64-bit) Supported Versions

Supported
Processor
Architectures

Windows Microsoft Windows 10 x86-64

Windows Server
● Windows Server 2016

x86-64

Linux
● SUSE Linux Enterprise Server 12.1 to 12.2

● Red Hat Enterprise Linux Server v6.x/6.3 - 6.9, and
v7.x/7.1 - 7.4

● CentOS Linux v6.x/6.3 - 6.9, and v7.x/7.1 - 7.4

● Oracle Linux v6.x/6.3 - 6.9, and v7.x/7.1 - 7.4

x86-64
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Minimum Disk Space and Memory Requirements
TIBCO Business Studio - Analyst Edition requires certain minimum disk space and memory requirements.

● Free disk space: from1.3 GB to 1.8 GB.

● Memory: minimum 1 GB RAM; the recommended level is 2 GB, or more depending on project sizes.

Third-party Software Requirements
Additional third-party software is required when you install TIBCO Business Studio - Analyst Edition.

The following software is required:

● JRE 1.8.x (included in installation). We recommend that users stay up to date with Java patches issued
by Oracle.

● Eclipse SWT (Standard Web Toolkit) GTK. An installation dialog comes up for accepting the license and
then gives an option to download the assembly from the TIBCO public website or select it from the disk.

You require a minimum GTK + version 2.24.

Compatibility
TIBCO Business Studio - Analyst Edition version 4.3.0 is compatible with specific versions of other TIBCO
products.

The products that TIBCO Business Studio - Analyst Edition version 4.3.0 (including Forms version 4.3.0) is
compatible with are as follows:

● TIBCO Business Studio - BPM Edition 4.3.0 which in turn is compatible with TIBCO ActiveMatrix® BPM
version 4.3.0

● TIBCO Nimbus™ version 10.0.0 to 10.x

Installer Accounts
You require certain privileges to install TIBCO Business Studio - Analyst Edition on Windows and Linux
platforms.

Microsoft Windows

You must have administrator privileges for the machine on which TIBCO Business Studio - Analyst Edition
is installed. If you do not have administrator privileges, the installer exits. You must then log out of the
system and log in as a user with the required privileges, or request your system administrator to assign the
privileges to your account.

After installing TIBCO Business Studio - Analyst Edition with administrator privileges, do not use the same
account to create a workspace for the user. Instead, individual users should start TIBCO Business Studio -
Analyst Edition from the account with which they intend to use TIBCO Business Studio - Analyst Edition,
and create their own workspace to avoid potential issues with permissions.

If you intend to install the product on a network drive, you must ensure that the account used for
installation has permission to access the network drive.

Linux

TIBCO Business Studio - Analyst Edition can be installed either as a root or a local user. TIBCO
recommends that you install as the user you plan to use for TIBCO Business Studio - Analyst Edition to
avoid any potential permissions issues.
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Installation Directories
You must install each version of TIBCO Business Studio - Analyst Edition into a new, empty installation
environment (separate from earlier versions of TIBCO Business Studio or other TIBCO products).

Do not install into the existing TIBCO_HOME directory, which is the default option.

You should create a new workspace for each installation of TIBCO Business Studio - Analyst Edition.

To do this, install TIBCO Business Studio - Analyst Edition as described in Installing in GUI Mode on
Windows. Specify a new, empty directory or create a new, empty directory as the environment location.

You may install TIBCO Business Studio - Analyst Edition into an existing installation environment if:

● you are reinstalling the same edition and version of TIBCO Business Studio - Analyst Edition in order to
repair a corrupt installation.

● you are sure none of the existing products in that installation environment conflict with the edition of
TIBCO Business Studio - Analyst Edition that you are installing.

Installer Log File
The installer log file is written to different locations depending on whether it is installed on Windows or
Linux platforms.

Windows 10, Windows Server 2016

User_Home\.TIBCO\install_identifier directory where identifier is in the form of the date and time
TIBCO Business Studio - Analyst Edition was installed and a unique number used to identify this particular
installation of TIBCO Business Studio - Analyst Edition.

For example,C:\Users\user-name\.TIBCO\install_03-02-2010.132827

Linux

$HOME/.TIBCO/install_identifier directory where identifier is in the form of the date and time TIBCO
Business Studio - Analyst Edition was installed and a unique number used to identify this particular
installation of TIBCO Business Studio - Analyst Edition.

For example, /home/user1/.TIBCO/install_03-02-2010.132827

Environment Information
Environment information for TIBCO Business Studio - Analyst Edition is contained in the file
_envInfo.xml .

The file _envInfo.xml is written to the following location for Windows: C:\Program Files\Common
Files\InstallShield\Universal\TIBCO\Gen1\_vpddb

Installing in GUI Mode on Windows
You can install TIBCO Business Studio - Analyst Edition in GUI Mode on Windows.

Prerequisites

Log in to the system on which you want to install TIBCO Business Studio - Analyst Edition (for more
information, see Installer Accounts).

Open the physical media or download the TIBCO Business Studio package to the machine on which you
want to install TIBCO Business Studio. Extract the installation files to a temporary directory.
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Procedure

1. Double-click TIBCOUniversalInstaller.

2. Review the information in the Welcome dialog and click Next.

Review the terms of the license agreement and, if you agree to them, click I accept the terms of the
license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

3. The TIBCO Installation Home dialog appears. TIBCO_HOME is the preferred top level installation
directory for all TIBCO products on your system. Select either:

● Create a new TIBCO_HOME. Click Browse to specify an environment location (a directory path to
an empty folder into which the software will be installed), or accept the default environment
location (which is the last directory in the path selected).

● Use an existing TIBCO_HOME. Select an existing TIBCO_HOME from the drop-down list.

The installer automatically creates an environment name for the location you specify. The default
environment name is studio-analyst-4.1. If this is not the first installation of TIBCO software, you
can edit the environment name to differentiate this subsequent installation of TIBCO software from
the first.

Click Next.

4. The Business Analyst profile is selected (this is the only profile available for TIBCO Business Studio -
Analyst Edition). The right hand pane displays the features that are selected for the profile. Click Next.

You will not need to use Customize Installation which is available but unchecked, as this
product only contains one feature.

5. After the installer configures your installation choices, the Pre-Install Summary dialog is displayed.
Review the information displayed in the dialog and make sure that it is correct. If you want to change
any of your choices, click Back to step back through the dialogs to the appropriate point and make your
choices again. When you are satisfied with your choices, click Install.

6. Once the installer has finished the installation tasks, the Running Product ANT Tasks dialog is
displayed. Click Show Details to see the tasks that the installer is performing.

7. The Post-Install Summary dialog is displayed. Click Finish to exit from the installer. There is a slight
delay while the installer deletes temporary files.

What to do next

Complete the post-installation tasks described in Perform Post Installation Upgrade Tasks

Installing in GUI Mode on Linux
You can install TIBCO Business Studio - Analyst Edition on Linux platforms.

Prerequisites

Log in to the system on which you want to install TIBCO Business Studio - Analyst Edition (for more
information, see Installer Accounts).

Open the physical media or download the TIBCO Business Studio - Analyst Edition package to the machine
on which you want to install TIBCO Business Studio - Analyst Edition. Extract the installation files to a
temporary directory.
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Procedure

1. Run the shell script TIBCOUniversalInstaller-lnx-xnn.bin.

2. Follow the installation steps which will be similar to those in Installing in GUI Mode on Windows other
than the following:

● Accept the Gnome License Agreement which uses the LGPL License

● Click on Download Gnome Binding assembly from TIBCO.

Failures in Linux Version 7 when TIBCO Business Studio uses the SWT Internal Browser
There are failures in Linux Version 7 (OEL7, CentOS 7, RHEL 7) when TIBCO Business Studio uses the SWT
internal browser (used for BPM Live Dev, Email Service Task, TIBCO Product Help view) and an error
message is displayed.

You will see the following error:

When you click OK you see the following error message.

To fix this you must install 64-Bit XULRunner 1.9.2. You need to download this from the Mozilla nightly
builds site: http://ftp.mozilla.org/pub/mozilla.org/xulrunner/nightly/2012/03/2012-03-02-03-32-11-
mozilla-1.9.2/

1. Extract the contents of the tar file by entering the following command: tar -xvif tar-file-name

2. To make the new XULRunner version available, update the TIBCO Business Studio .ini file and add
the following Java VM arguments (vmargs) in the file: -
Dorg.eclipse.swt.browser.XULRunnerPath=pathto-XULRunner.

● Note: This update applies to a specific instance of TIBCO Business Studio. If the instance of TIBCO
Business Studio was installed for an individual user, the update only applies to that user. If TIBCO
Business Studio was installed as a shared instance that is used by multiple users, the update applies
to all users of the shared instance.

● The following procedure makes the new version available to all users on the system:

— As user root, extract the XULRunner runtime directory to a location that is accessible to all
users, for example, /usr/lib/xulrunner-1.9.2.
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— From the XULRunner directory, enter the following command:./xulrunner --register-
global

● The following procedure makes the new version available to an individual user

— Extract the XULRunner runtime directory to the home directory of the user.

— From the XULRunner directory, enter the following command:./xulrunner --register-user

Registering XULRunner persists across the system and TIBCO Business Studio
restarts.

3. Restart TIBCO Business Studio and confirm that the issues have been resolved.

Installing in Silent Mode (All Platforms)
You can install TIBCO Business Studio - Analyst Edition in silent mode on all platforms.

Prerequisites

The TIBCOUniversalInstaller.silent file is packaged in the directory that contains the universal
installer. You must edit the file with information for your environment before launching the silent
installation. The file includes comments that describe the installation properties you can set.

While you can use the TIBCOUniversalInstaller.silent file, it’s good practice to copy the file to a
different name and use that file for the silent install.

If errors occur during installation, they will be listed in the installation log file (see the User_Home/.TIBCO
directory).

Procedure

1. Open the physical media or download the TIBCO Business Studio - Analyst Edition product package.

2. Extract the TIBCO Business Studio - Analyst Edition product archive file to a temporary directory.

3. Using a console window, navigate to the temporary directory that contains the universal installer.

4. Copy the TIBCOUniversalInstaller.silent file and rename the file as myfilename.silent.

5. Using a text editor, open the copied file and update the install location, and the list of features to install.

6. Run the installer: TIBCOUniversalInstaller -silent -V responseFile="myfilename.silent"

If you are using the TIBCOUniversalInstaller.silent file, you need not supply the file name and can
run: TIBCOUniversalInstaller -silent.

What to do next

Complete the post-installation tasks described in Perform Post Installation Upgrade Tasks .

Perform Post Installation Upgrade Tasks
After installation, there are a number of tasks you can perform to ensure that your system runs efficiently.

Deletion of the Temporary Installation Files
If you want to recover the disk space used by the installation files that you extracted to a temporary
directory in the installation, delete them.

9

TIBCO Business Studio™- Analyst Edition Installation



Uninstalling TIBCO Business Studio - Analyst Edition

You can uninstall TIBCO Business Studio - Analyst Edition from your system.

When you uninstall, some files are currently left behind that are not user data. You can remove these files
manually if required.

Linux

1. Open a terminal.

2. Navigate to STUDIO_HOME/tools/universal_installer.

3. Run the uninstaller named TIBCOUniversalInstaller-lnx-x86-64.bin.

Windows

Do one of the following:

● Use the uninstaller provided with TIBCO Business Studio - Analyst Edition.

● Remove the installation using the Programs and Features option in Control Panel on Windows System.

When you installed TIBCO Business Studio - Analyst Edition, if the installer detected a
suitable Java Virtual Machine (JVM), that JVM is used by TIBCO Business Studio - Analyst
Edition. The uninstallation will fail if you remove the JVM used by TIBCO Business Studio -
Analyst Edition before removing TIBCO Business Studio - Analyst Edition. If this happens,
you can use the command line to uninstall with the -is:javahome option.

To do this, navigate to the STUDIO_HOME/tools/universal_installer folder and enter the
following command TIBCOUniversalInstaller-x86-64.exe -is:javahome <JRE_HOME>
.

Using the Uninstaller
You can uninstall TIBCO Business Studio - Analyst Edition using the uninstaller.

Procedure

1. Log into the system on which you want to uninstall software.

2. Launch the uninstaller as described in the previous section. For example, from C:\Studio
\Analyst-400\tools\universal_installer.

3. The Welcome dialog is displayed. Click Next.

4. Select Typical to uninstall all products in the environment.

5. The Ready to Uninstall dialog is displayed.

If you want to change any of your choices, click Back to step back through the dialogs to the appropriate
point. You can then restart the uninstallation process from that point.

6. When you are satisfied with your choices, click Uninstall.

The uninstaller removes the software product you specified.

The TIBCO Business Studio - Analyst Edition entries in the Start menus may appear after the
uninstallation. To correct this log out, then log in again.
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Using Programs and Features (Windows Only)
You can remove the installation using the Programs and Features option on your PC.

Procedure

1. Log in to Windows as a user with system administrator privileges. You must have system administrator
privileges to uninstall this software.

2. In the Control Panel, double-click Programs and Features.

3. In the Add/Remove Programs dialog, select TIBCO Universal Installer(installation_environment_n) ,
where installation_environment_n is the directory corresponding to the installation environment you
want to uninstall. If you have installed more than one TIBCO product, there will be multiple entries in
Programs and Features (for example, TIBCO Universal Installer (c:\tibco\env_1), TIBCO Universal
Installer (c:\tibco\env_2), and so on).

4. Click Uninstall/Change.

The uninstaller launches. Follow the uninstallation steps in Using the Uninstaller.

The uninstaller may not completely remove files that have been modified since the initial
installation (for example, the configuration directory). If you do not need any of the other
remaining files, manually delete them.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.
The website is updated frequently and is more current than any other documentation included with the
product.

Product-Specific Documentation

The following documentation for TIBCO Business Studio is available on the TIBCO Business Studio
Product Documentation page:

● TIBCO Business Studio™ Release Notes

● TIBCO Business Studio™ Concepts

● TIBCO Business Studio™ Modeling User's Guide

● TIBCO Business Studio™ - Analyst Edition User's Guide

● TIBCO Business Studio™ - BPM Implementation

● TIBCO Business Studio™ Forms User's Guide

● TIBCO Business Studio™ Simulation User's Guide

● TIBCO Business Studio™ Customization

● TIBCO Business Studio™ - Analyst Edition Installation

● TIBCO Business Studio™ - BPM Edition Installation

● TIBCO Business Studio™ iProcess to BPM Conversion

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, Enterprise Message Service, Business Studio, and ActiveMatrix
are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms
for a specific software version are released at the same time. See the readme.txt file for the availability of
this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED
IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2004-2022. TIBCO Software Inc. All Rights Reserved.
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